
OSSSC CRE 2025
Combined Recruitment Examination · Preliminary · Question Paper

10 Jun 2026 · 12:30 PM - 2:00 PM English Version

RI · ICDS Supervisor · VAW · JA · ARI · Amin · SFS  |  Official Answer Key

About this Paper

This is the OSSSC Combined Recruitment Examination (CRE) 2025 Preliminary written test (Advt. IIE-120/2025-3219) for the posts of
Revenue Inspector, ICDS Supervisor, Village Agricultural Worker, Junior Assistant, Assistant Revenue Inspector, Amin & Statistical Field
Surveyor — 10 Jun 2026, 12:30 PM - 2:00 PM shift, English version, with the correct option marked as per the official answer key.

Exam pattern: 100 questions · 100 marks · 90 minutes. Sections: Mathematics 20, General Studies 20, English 20, Odia 15, Computer
15, Logical Reasoning 10. Marking: +1 correct, −0.25 wrong.

✓ Correct option (highlighted green)

More from QMaths

Check your marks & All-India rank at rank.qmaths.in. Master English vocabulary with the Blackbook app.

Toppers' Choice, Blackbook of English Vocabulary, Now available in App format : DOWNLOAD NOW

https://rank.qmaths.in/
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25


Paper Set 1 · 10 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
A store offers a “BUY ONE GET ANOTHER ONE 45% OFF” scheme on
an article. If the marked price of an article is ₹800, how much will a
customer pay for two articles?

A.  A. ₹1,200

B.  B. ₹1,220

C.  D. ₹1,240

D.  C. ₹1,280

✓

Q2 Quant
If the cost of 7 metres of cloth is ₹315, find the cost of 2.5 metres of
the same cloth.

A.  C. ₹100

B.  D. ₹105.50

C.  A. ₹110.25

D.  B. ₹112.50

✓

Q3 Quant
Two trains, A and B, are running in opposite directions on parallel
tracks. Train A is 180 m long and moving at 54 km/hr, while train B is
120 m long and moving at 36 km/hr. Find the time taken by the
faster train (A) to cross a man standing on the platform.

A.  D. 10 seconds

B.  C. 12 seconds

C.  B. 14 seconds

D.  A. 15 seconds

✓

Q4 Quant
A quadrilateral ABCD has sides such that AB=DC and BC=DA. If its
diagonal intersects at right angle, what is the type of quadrilateral
ABCD?

A.  A. Rectangle

B.  C. Kite

C.  B. Rhombus

D.  D. Square

✓

Q5 Quant
A, B, and C can paint a house in 20 days, 30 days, and 60 days,
respectively. If all three work together, in how many days will the
house be painted completely?

A.  8 days

B.  10 days

C.  12 days

D.  15 days

✓

Q6 Quant
If 16 workers can complete a job in 2x days (x > 0), then how many
days will the same 8 workers take to complete the job ?

A.  A. x days

B.  B. 2x days

C.  C. 4x days

D.  D. 3x days

✓

Q7 Quant
Find the mode of the given data (rounded off to two decimal places).

Class interval 0-6 6-12 12-18

Frequency 4 6 8

A.  C. 10.64

B.  B. 11.38

C.  D. 12.69

D.  A. 13.71

✓

Q8 Quant
The average age of 35 students of a class is 14 years. When the age
of the class teacher is included, the average becomes 15 years. What
is the age of the class teacher?

A.  A. 40 years

B.  B. 45 years

C.  D. 48 years

D.  C. 50 years
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Q9 Quant
Rajiv and Sachin started a business by investing ₹240 and ₹120,
respectively. If Sachin's share in the profit earned by them is ₹930,
what is the total profit (in ₹) earned by them together?

A.  C. 2790

B.  A. 2886

C.  D. 2744

D.  B. 2750

✓

Q10 Quant
Subtracting 19% of X from X is equal to multiplying X by:377

A.  A. 0.81

B.  C. 0.19

C.  B. 0.5

D.  D. 0.019

✓

Q11 Quant
One pipe can fill a tank in 3 minutes, while another pipe can empty
the completely filled tank in 12 minutes. If both the pipes are
opened together when the tank is empty, how many minutes will it
take to fill three-fourths of the tank?

A.  A. 3

B.  B. 6

C.  D. 4

D.  C. 7

✓

Q12 Quant
If △ABC is similar to △RST and the area of △ABC is four times the
area of △RST, and AB = 12 cm, then find the length of RS.3043

A.  B. 6 cm

B.  A. 9 cm

C.  C. 8 cm

D.  D. 3 cm

✓

Q13 Quant
Ajay gets double the amount in 4 years when invested at compound
interest, compounded annually. In how many years will the amount
become sixteen times the original amount?

A.  C. 16

B.  A. 8

C.  B. 32

D.  D. 34

✓

Q14 Quant
A dealer buys an article with a marked price of ₹25,000 with
successive discounts of 20% and 5%. He spends ₹1,000 on its repairs
and sells it for ₹25,000. What is his profit percentage?

A.  D. 20%

B.  B. 25%

C.  C. 15%

D.  A. 10%
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✓

Q15 Quant

A.  

B.  

C.  

D.  

✓

Q16 Quant

A.  A. 114

B.  C. 100

C.  B. 92

D.  D. 90

✓

Q17 Quant

Find the value of x that satisfies the equation: 4(4x2 - 5) - 4(4x2 + 7x - 7) = 20

A.  

B.  

C.  

D.  

✓

Q18 Quant
If a car travels 50 km at 30 km/h, 80 km at 40 km/h, and 70 km at 35 km/h, the average speed (in km/h) is:

A.  

B.  

C.  

D.  

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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Q19 Quant

A.  C. 28%

B.  A. 30%

C.  B. 32%

D.  D. 34%

✓

Q20 Quant
Two partners invest ₹12,500 and ₹8,500, respectively, in a business. They agree that 60% of the profit should be divided equally between them,
and the remaining 40% of the profit should be shared in proportion to their capitals. If the partner with the higher investment gets ₹600 more
than the other, then the total profit made in the business is:

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
An artificial kidney is a device to remove nitrogenous waste products
from the blood through dialysis. It consists of:

A.  A. a blood reservoir and cooling system

B.  D. a nephron-mimicking microchip

C.  B. renal artery and renal vein

D.  C. a dialyzer with a semi-permeable membrane

✓

Q22 GA
Which Indian actor announced the launch of his fourth book titled
'Different but No Less' in September 2025?

A.  C. Naseeruddin Shah

B.  B. Shah Rukh Khan

C.  A. Anupam Kher

D.  D. Amitabh Bachchan

✓

Q23 GA
The Kuka Movement, which initially began as a religious purification
movement, later became a political movement in which of the
following States?

A.  A. Punjab

B.  B. Gujarat

C.  D. Bengal

D.  C. Madhya Pradesh

✓

Q24 GA
In 2026, the NIGRANI App, Haj Wrist Band, and AI Chatbots were
launched during the Chintan Shivir by the Union Minister heading
which ministry?

A.  D. Ministry of Home Affairs

B.  C. Ministry of Minority Affairs

C.  B. Ministry of Tourism

D.  A. Ministry of Social Justice and Empowerment

✓

Q25 GA
An important characteristic of S-waves (secondary waves) that is
useful for understanding Earth's interior structure is that they can
travel only through which material state?

A.  D. Gaseous materials

B.  A. Liquid materials

C.  C. Solid materials

D.  B. Solid and liquid materials
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Q26 GA
Which Odisha politician, in October 2025, admonished revenue
officers to prioritise citizen-friendly service delivery, emphasising the
simplification of revenue laws and faster resolution of land-related
matters?

A.  A. Mohan Charan Majhi

B.  B. Suresh Pujari

C.  D. Prithviraj Harichandan

D.  C. Deoranjan Kumar Singh

✓

Q27 GA
Which peak holds the record for the greatest height in Odisha?

A.  D. Mahendragiri

B.  A. Malayagiri

C.  C. Gandhamardan

D.  B. Deomali

✓

Q28 GA
Which African nation made history by qualifying for the FIFA World
Cup finals for the first time in 2025 after beating Eswatini 3-0?

A.  A. Cabo Verde

B.  B. Iceland

C.  C. Malta

D.  D. Luxembourg

✓

Q29 GA
What is the duration of the 'YUVA Artificial Intelligence for ALL'
course launched in November 2025?

A.  C. 4.5 hours

B.  D. 5.5 hours

C.  B. 6.5 hours

D.  A. 7.5 hours

✓

Q30 GA
The Odisha Tourism (Amendment) Policy, 2026, amended which
earlier tourism policy framework of the State?

A.  D. Odisha Tourism Policy, 2016

B.  C. Odisha Tourism Policy, 2022

C.  A. Odisha Ecotourism Policy, 2021

D.  B. Odisha Hospitality Promotion Policy, 2023

✓

Q31 GA
Which of the following best explains the historical significance of
Matanga's Brihaddeshi in the evolution of Indian music forms?

A.  B. It introduced the concept of Sapta Svaras for the first time
in Indian music.

B.  D. It established the dominance of Vedic chanting as the only
form of classical music.

C.  C. It marked the emergence and aesthetic development of
the concept of raga in Indian music.

D.  A. It formalized the division between Hindustani and Carnatic
music systems.

✓

Q32 GA
When a concave lens forms an image of an object placed at infinity,
what is the nature and position of the image?

A.  A. The image is real, erect, and formed at the optical center

B.  B. The image is virtual, erect, and formed at the principal
focus

C.  C. The image is virtual, inverted, and formed at twice the
focal length

D.  D. The image is real, inverted, and formed at the focal plane

✓

Q33 GA
The seminal report ‘Our Common Future’ links the concept of ‘needs’
most closely to which aspect of sustainable development?

A.  A. Promotion of technological innovation as the main goal

B.  C. Expansion of industrial output for economic progress

C.  D. Conservation of biodiversity above all else

D.  B. Distribution of resources to ensure basic needs for all

✓

Q34 GA
The Preamble to the Indian Constitution was adopted on ________.

A.  C. 15-Aug-1947

B.  B. 26-Jan-1950

C.  A. 26-Nov-1949

D.  D. 02-Oct-1948

✓

Q35 GA
Which neighboring country lies to the northwest of India and shares
a boundary along the states of Punjab and Rajasthan?

A.  B. Nepal

B.  C. Bhutan

C.  D. Pakistan

D.  A. Myanmar
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Q36 GA
Which indicator in the Census of India is calculated as the number of
females per 1000 males in the population?

A.  A. Dependency Ratio

B.  D. Population Density

C.  C. Growth Rate

D.  B. Sex Ratio

✓

Q37 GA
Which classical dance form of India originated in the state of Tamil
Nadu?

A.  B. Kathak

B.  A. Bharatanatyam

C.  D. Kathakali

D.  C. Odissi

✓

Q38 GA
Which term refers to a continuous rise in the general price level?

A.  A. Deflation

B.  B. Inflation

C.  C. Stagflation

D.  D. Recession

✓

Q39 GA
The Utkal Brahmo Samaj in Cuttack was established in which year?

A.  C. 1857

B.  A. 1869

C.  D. 1875

D.  B. 1882

✓

Q40 GA
A _______ is a substance composed of two or more elements,
chemically combined with one another in a fixed proportion.

A.  A. compound

B.  D. mixture

C.  B. matter

D.  C. pure substance

English

✓

Q41 English
Parts of a sentence are given below in jumbled order. Select the option in which the parts are arranged in the correct order to form a
meaningful sentence.

Mother Teresa / one / is / of / of / the / missionaries / our / greatest / time

A.  B. Mother Teresa the greatest is one of missionaries of our time.

B.  A. One of the greatest missionaries is of our time Mother Teresa.

C.  D. Mother Teresa is one of the greatest missionaries of our time.

D.  C. Mother Teresa one of the greatest missionaries is of our time.

✓

Q42 English
Select the correct one-word substitute for the underlined group of words in the given sentence.

He felt low on vitality after the classes.

A.  C. untarnished

B.  A. sluggish

C.  D. energetic

D.  B. knowledgeable
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Q43 English

Read the passage carefully and answer the following questions.

In the history of science, few names are as significant as Marie Curie. She was born in Warsaw, Poland in 1867 and became a highly influential
figure in physics and chemistry due to her strong determination and thirst for knowledge. Marie Curie faced many challenges in her early years,
especially because she was a woman in a field dominated by men. However, she didn't let this discourage her. She excelled in her studies and
eventually went to Paris for further education, where she met Pierre Curie, a fellow scientist who later became her husband and research partner.
Together, the Curies explored the mysterious world of radioactivity and made groundbreaking discoveries, identifying two new elements:
polonium and radium. Marie Curie became the first woman to win a Nobel Prize and later, the first person to win two Nobel Prizes in different
scientific areas. But her contributions went beyond discoveries. She pioneered radiotherapy, using radium to treat cancer.

According to the passage, which two elements were discovered by Marie Curie?

A.  D. rhodium and polonium

B.  B. polonium and radium

C.  A. cobalt and neon

D.  C. sodium and radium

✓

Q44 English
Select the most appropriate antonym of the word 'significant'.

A.  B. negligible

B.  D. accountable

C.  C. comfortable

D.  A. effable

✓

Q45 English
Select the most appropriate tone of the passage.

A.  D. Factual

B.  C. Delightful

C.  A. Blunt

D.  B. Comic

✓

Q46 English
Select the most appropriate title for the passage.

A.  A. Marie Curie: The Quantum Matriarch

B.  B. Marie Curie's Doctoral Thesis

C.  C. The life and legacy of Marie Curie

D.  D. Case Files: Marie Curie

✓

Q47 English
Which of the following statements is not true in the context of the passage?

A.  B. Marie Curie pioneered radiotherapy.

B.  A. She discontinued her research after her husband's death.

C.  C. She did not contribute to advancement of medicine.

D.  D. She faced lots of challenges in her life.
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Q48 English
In the following question, a statement is given with highlighted text. You are required to replace the text with the correct proverb given in the
options.

In Sudha Murty's novels, it is often showcased that happiness is better than wealth, and characters are encouraged to value contentment
over riches.

A.  A. a happy heart is better than a full purse

B.  B. a penny saved is a penny earned

C.  D. money makes the mare go

D.  C. money makes the world go around

✓

Q49 English
Read the options carefully and choose the one written in correct passive voice.

A.  A. The opera house was lit up beautifully at night.

B.  B. The festival decorated by the townspeople.

C.  C. The surfers are enjoy the waves.

D.  D. The desert bloom each spring.

✓

Q50 English
Select the option that correctly substitutes the wrong word-segment of the given proverb.

Still mountains run deep.

A.  C. Still waters run deep.

B.  B. Still pictures run deep.

C.  D. Still waterfalls run deep.

D.  A. Still rivers run deep.

✓

Q51 English
Choose the correct option to complete the sentence.
She faced repeated failures; ______, she refused to give up and kept trying harder.

A.  C. certainly

B.  A. nevertheless

C.  D. consequently

D.  B. meanwhile

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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Q52 English

A sentence in indirect speech is given below. Complete its correct direct form by choosing the appropriate option.
Indirect:
Ravi said that he was planning to start a new venture.
Direct:
Ravi said, “__________________________.”

A.  B. I am planning to start a new venture

B.  C. I was planning to start a new venture

C.  A. He will be planning to start a new venture

D.  D. I plan to start a new venture now

✓

Q53 English
A sentence divided into different segments has been given. Rearrange the segments to form a coherent sentence.

(P) with her friends
(Q) to the zoo
(R) last weekend
(S) Anu went

A.  C. S Q P R

B.  B. Q P S R

C.  D. P S Q R

D.  A. S R Q P

✓

Q54 English
Select the most appropriate option from the given alternatives to fill in the blank.

This time next week, we _____ on the beach enjoying our holiday.

A.  B. will be lying

B.  C. will have lied

C.  A. will lie

D.  D. will be lain

✓

Q55 English
Select the most suitable option to complete the sentence.

The teacher ______ the students to complete their assignments by Friday.

A.  D. instruct

B.  C. have instruct

C.  B. instructing

D.  A. instructed
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Q56 English
Choose the correct antonym of the underlined word in the given sentence.

The government adopted a stringent policy to regulate environmental violations.

A.  A. progressive

B.  C. regressive

C.  D. liberal

D.  B. regulatory

✓

Q57 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

Can you pass me ___ salt on the table?

A.  D. an

B.  C. a

C.  B. the

D.  A. no article required

✓

Q58 English
Choose the word opposite in meaning to the underlined word in the given sentence.

After the scandal, the politician's reputation was tarnished.

A.  D. Cleansed

B.  A. Stained

C.  B. Obscured

D.  C. Poisoned

✓

Q59 English
Select the most appropriate option to substitute the underlined segment in the given sentence.

With the eye of someone who shapes solid forms from materials like metal or stone to represent people or ideas, Paolozzi roamed the scrap
lots and ship-salvage yards of Hamburg, looking for bits of metal.

A.  A. an architect

B.  C. a potter

C.  D. a sculptor

D.  B. a curator

✓

Q60 English
In the given sentence, four words are marked in bold. Choose the word which is wrongly spelt.

The teacher was immensely patient, knowlegeable, and dedicated to her students.

A.  C. immensely

B.  A. patient

C.  B. knowlegeable

D.  D. dedicated
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✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ପ୍ର ଦୂ ଷଣ ରୋକି ବା ପାଇଁ  ନୂ ତନ ବି ଧି  ଲାଗୁ  ହେବ।

A.  A. A new law will be promoted to stop pollution.

B.  D. New method to stop crime will begin.

C.  B. A new law will be enforced to stop pollution.

D.  C. A new law will be increase to stop pollution.

✓

Q62 Odia
‘ଆକାଶ କୁ ସୁ ମ’ ରୂ ଢି ର ଅର୍ଥ  କ’ଣ?

A.  D. ଆକାଶରେ ଫୁ ଲ ଫୁ ଟି ଛି

B.  A. ଯାହା କେବେ ହେବାର ନାହିଁ

C.  C. ମେଘରୁ  ଫୁ ଲ ଝଡ଼ୁଛି

D.  B. ଆକାଶ ରଙ୍ଗା ଫୁ ଲରେ ଭରତି

✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ସ୍ଵାଧୀନତା ଦି ବସ ପାଳନ ଉପଲକ୍ଷେ ଆମ ସୋସାଇଟି  ରେ ମଧ୍ୟାନ୍ନ ଭୋଜନ ର ବ୍ୟବସ୍ଥା କରାଯାଇଥି ଲା ।

A.  B. A luncheon party was organized in our society during Independence day celebration.

B.  A. On 15th of August, a lunch will be organized in our society.

C.  C. On independence day, lunch was organized.

D.  D. A luncheon party was organized in our society.

✓

Q64 Odia
“ଅଣ୍ଟାରେ ନ ଥାଇ ଧନ, ପୁ ଅ ବାହା କରି  ମନ” ଲୋକବାଣୀର ଅର୍ଥ  କ’ଣ?

A.  B. ଧନହୀନ ଲୋକ ଅଧି କ ଖର୍ଚ୍ଚ  କରି ବାର ଯୋଜନା ହାସ୍ୟାସ୍ପଦ

B.  A. ଧନୀ ଲୋକ ବି ବାହ କରନ୍ତି

C.  C. ବି ବାହରେ ଏତେ ଖର୍ଚ୍ଚ  ଦରକାର ନାହିଁ

D.  D. ଧନହୀନ ଲୋକ ଅଧି କ ଖର୍ଚ୍ଚ  କରେ

✓

Q65 Odia
“ଏକା ଭାଡ଼ି ର ପାରା” ଲୋକବାଣୀର ଅର୍ଥ  କ’ଣ?

A.  B. ଏକାକୀ ଲୋକ

B.  A. ପାରାମାନେ ବାସ କରୁ ଥି ବା ଜାଗା

C.  C. ପାରା ମାନଙ୍କର ବାସସ୍ଥଳୀ

D.  D. ଗୋଟି ଏ ସ୍ୱଭାବର ବ୍ୟକ୍ତି  ବୃ ନ୍ଦ
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✓

Q66 Odia
"ସେ କି ନ୍ତୁ ଏ କଥା ଜାଣି  ନାହାନ୍ତି " - ଏଠାରେ 'କି ନ୍ତୁ' ଯଦି  ବାକ୍ୟର ସୌନ୍ଦର୍ଯ୍ୟ  ପାଇଁ  ବ୍ୟବହୃ ତ ହୋଇଥାଏ, ତେବେ ତାକୁ  କେଉଁ  ଅବ୍ୟୟ କୁ ହାଯି ବ?

A.  D. ସଂଯୋଜକ

B.  B. ଆଳଙ୍କାରି କ

C.  A. ବି ଶେଷଣର ବି ଶେଷଣ

D.  C. ସମ୍ବୋଧନ ସୂ ଚକ

✓

Q67 Odia
'ହରି  କାମଟି  ତରତର ହୋଇ କରୁ ଛି ' ଏଠାରେ 'ତରତର' କେଉଁ  ଶ୍ରେ ଣୀର ଅନ୍ତର୍ଭୁ କ୍ତ?

A.  D. ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  C. କ୍ରି  ୟା ବି ଶେଷଣ

C.  A. ସର୍ବ ନାମ

D.  B. କ୍ରି  ୟାଜ ବି ଶେଷଣ

✓

Q68 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ସମୟସୂ ଚକ ଅବ୍ୟୟ କେଉଁ ଟି  ?

A.  C. ଏଠାରେ

B.  B. ଏବେ

C.  A. ବହୁ ତ

D.  D. କି ନ୍ତୁ

✓

Q69 Odia
ନି ମ୍ନ ଲି ଖି ତ ବାକ୍ୟଗୁ ଡି କରେ ଭୁ ଲ ବନାନ ଚି ହ୍ନଟ କରି  ଠି କ୍  ବାକ୍ୟ ବାଛ ।

A.  C. ରାତି ରେ ଗ୍ରା ମଟି  ବହୁ ତ ନୀର୍ଜ ନ ଲାଗୁ ଥି ଲା ।

B.  D. ରାତି ରେ ଗ୍ରା ମଟି  ବହୁ ତ ନି ର୍ଜ ନ ଲାଗୁ ଥି ଲା ।

C.  A. ରାତି ରେ ଗ୍ରା ମଟି  ବହୁ ତ ନି ର୍ଯ ନ ଲାଗୁ ଥି ଲା ।

D.  B. ରାତି ରେ ଗ୍ରା ମଟି  ବହୁ ତ ନୀର୍ଯ ନ ଲାଗୁ ଥି ଲା ।

✓

Q70 Odia
"Fortune favors the brave." - ଏହାର ପ୍ରା ସଙ୍ଗି କ ଓଡ଼ି ଆ ଅନୁ ବାଦ କେଉଁ ଟି ?

A.  D. ଭାଗ୍ୟ ସାହସୀଙ୍କୁ  ସାହାଯ୍ୟ କରେ ।

B.  A. ସାହସୀ ଲୋକ ଭାଗ୍ୟବାନ ।

C.  B. ଭାଗ୍ୟବାନ ଲୋକ ସାହସୀ ହୁ ଅନ୍ତି  ।

D.  C. ସାହସ ଥି ଲେ ଭାଗ୍ୟ ବଦଳେ ।
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✓

Q71 Odia

ପ୍ର ଦତ୍ତ ଅନୁ ଚ୍ଛେଦ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ପ୍ର ଶ୍ନ ର ସଠି କ ଉତ୍ତର ବାଛ |
ଗତ ଶନି ବାର ଦି ନ, ଆମ ଶ୍ରେ ଣୀର ସମସ୍ତ ଛାତ୍ର ଛାତ୍ରୀ  ମି ଶି  ସହରରେ ଅବସ୍ଥି ତ ଏକ ପ୍ର ସି ଦ୍ଧ ତଥା ଐତି ହାସି କ ସଂଗ୍ର ହାଳୟ ପରି ଦର୍ଶ ନ କରି ବାକୁ  ଯାଇଥି ଲୁ । ସେହି  ସଂଗ୍ର ହାଳୟ ମଧ୍ୟରେ ସଂରକ୍ଷି ତ
ହୋଇ ରହି ଥି ବା ବି ଭି ନ୍ନ ପ୍ରା ଚୀନ କଳାକୃ ତି , ମୂ ଲ୍ୟବାନ ହାତଲେଖା ପାଣ୍ଡୁଲି ପି  ଏବଂ ଅତି  ସୁ ନ୍ଦର ଭାସ୍କର୍ଯ୍ୟ ଗୁ ଡ଼ି କ ଆମକୁ  ଶତାବ୍ଦୀ ଶତାବ୍ଦୀ ପୂ ର୍ବ ରୁ  ବସବାସ କରୁ ଥି ବା ଲୋକମାନଙ୍କର ସାମାଜି କ
ଜୀବନଶୈ ଳୀ, ସଂସ୍କୃତି  ଓ ଚଳଣି  ବି ଷୟରେ ଏକ ସ୍ପଷ୍ଟ ଏବଂ ସୁ ନ୍ଦର ଝଲକ ପ୍ର ଦାନ କରି ଥି ଲା। ଏହି  ଜ୍ଞାନବର୍ଦ୍ଧ କ ପରି ଦର୍ଶ ନ ମାଧ୍ୟମରେ ଆମେ ଆମର ପୁ ରାତନ ପାରମ୍ପରି କ ରୀତି ନୀତି , ବି ଭି ନ୍ନ
ଶୈ ଳୀର ଚି ତ୍ତାକର୍ଷ କ କଳା ରୂ ପ ଏବଂ ଅତୀତର ଅନେକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଐତି ହାସି କ ଘଟଣାବଳୀ ବି ଷୟରେ ବହୁ ତ କି ଛି  ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ତଥ୍ୟ ଶି ଖି ବାକୁ  ଏବଂ ବୁ ଝି ବାକୁ  ପାଇଲୁ । ଏହା ବ୍ୟତୀତ, ସଂଗ୍ର ହାଳୟ
ପରି ସର ମଧ୍ୟରେ କି ଛି  ବି ଶେଷ ପ୍ର କାରର ପାରସ୍ପରି କ କ୍ରି  ୟାଶୀଳ ପ୍ର ଦର୍ଶ ନୀର ମଧ୍ୟ ବ୍ୟବସ୍ଥା କରାଯାଇଥି ଲା। ସେହି  ସ୍ଥାନରେ ଆମ ଶ୍ରେ ଣୀର ଛାତ୍ର ଛାତ୍ରୀ ମାନେ ନି ଜେ ପୁ ରାତନ କାଳର ବି ଭି ନ୍ନ
ଲି ପି ରେ ଲେଖି ବା ପାଇଁ  ଚେଷ୍ଟା କରି ଥି ଲେ ଏବଂ ପ୍ରା ଚୀନ କାଳର କି ଛି  ପ୍ର ସି ଦ୍ଧ ଚି ତ୍ର ଗୁ ଡ଼ି କର ସଫଳତାର ସହ ପୁ ନଃ ନି ର୍ମା ଣ କରି ବାର ଏକ ଅପୂ ର୍ବ  ତଥା ରୋମାଞ୍ଚକର ଅନୁ ଭୂ ତି  ହାସଲ କରି ପାରି ଥି ଲେ।
ପ୍ର କୃ ତରେ କହି ବାକୁ  ଗଲେ, ଏହି  ଶି କ୍ଷଣୀୟ ଯାତ୍ରା ଟି  ବହି  ପୃ ଷ୍ଠାରେ ଥି ବା ନି ରସ ଇତି ହାସକୁ  ଆମ ସମସ୍ତଙ୍କ ସାମ୍ନା ରେ ସମ୍ପୂ ର୍ଣ୍ଣ  ରୂ ପେ ଜୀବନ୍ତ ଏବଂ ବାସ୍ତବ କରି ଦେଇଥି ଲା। ଏହି  ସ୍ମରଣୀୟ ଅନୁ ଭୂ ତି  ଆମ
ଶ୍ରେ ଣୀର ଅନେକ ଛାତ୍ର ଛାତ୍ରୀ ଙ୍କ ମନରେ ଏକ ଗଭୀର ରେଖାପାତ କରି ଥି ଲା ଏବଂ ନି ଜର ସମୃ ଦ୍ଧ ଐତି ହ୍ୟ ତଥା ଗୌରବମୟ ଇତି ହାସ ବି ଷୟରେ ଅଧି କରୁ  ଅଧି କ ଗବେଷଣା ଏବଂ ଅନୁ ସନ୍ଧାନ କରି ବା
ପାଇଁ  ସମସ୍ତଙ୍କୁ  ବହୁ ତ ଅନୁ ପ୍ରା ଣି ତ ଓ ଉତ୍ସାହି ତ କରି ଥି ଲା।

ଅତୀତ ବି ଷୟରେ ଜାଣି ବା ପାଇଁ  ଛାତ୍ର ମାନେ କେଉଁ  ପ୍ର କାରର ସାମଗ୍ରୀ  ଦେଖି ଲେ?

A.  D. ଆଧୁ ନି କ ପ୍ର ଯୁ କ୍ତି ବି ଦ୍ୟା ଏବଂ ଗ୍ୟାଜେଟ୍

B.  C. ଜୀବନ୍ତ ପଶୁ  ଏବଂ ଉଦ୍ଭି ଦ

C.  A. ପ୍ରା ଚୀନ କଳାକୃ ତି , ପାଣ୍ଡୁଲି ପି  ଏବଂ ଭାସ୍କର୍ଯ୍ୟ

D.  B. ମହାକାଶ ଉପକରଣ ଏବଂ ଦୂ ରବୀକ୍ଷଣ ଯନ୍ତ୍ର

✓

Q72 Odia
ଗତ ଶନି ବାର ଶ୍ରେ ଣୀ କେଉଁ ଠାକୁ  ଯାଇଥି ଲା?

A.  C. ଏକ ବି ଜ୍ଞାନ କେନ୍ଦ୍ର

B.  A. ଏକ ଐତି ହାସି କ ସଂଗ୍ର ହାଳୟ

C.  B. ଏକ କଳା ଗ୍ୟାଲେରୀ

D.  D. ଏକ ଉଦ୍ଭି ଦ ଉଦ୍ୟାନ

✓

Q73 Odia
ପାରସ୍ପରି କ କ୍ରି  ୟାଶୀଳ ପ୍ର ଦର୍ଶ ନୀର ଏକ ସ୍ୱତନ୍ତ୍ର ବୈ ଶି ଷ୍ଟ୍ୟ କଣ ଥି ଲା?

A.  B. ଭବି ଷ୍ୟତ ବି ଷୟରେ 3D ଚଳଚ୍ଚି ତ୍ର  ଦେଖି ବା

B.  C. ଭି ଡି ଓ ଗେମ୍  ଖେଳି ବା

C.  D. ପୁ ରାତନ ଲି ପି ରେ ଲେଖି ବା ଏବଂ ପ୍ରା ଚୀନ ଚି ତ୍ର ର ପୁ ନଃ ନି ର୍ମା ଣ କରି ବା

D.  A. ଆଧୁ ନି କ ପପ୍  ସଙ୍ଗୀତ ଶୁ ଣି ବା
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✓

Q74 Odia
ସଂଗ୍ର ହାଳୟ ପରି ଦର୍ଶ ନର ଛାତ୍ର ମାନଙ୍କ ଉପରେ ସାମଗ୍ରି  କ ପ୍ର ଭାବ କଣ ଥି ଲା?

A.  B. ଏହା ସେମାନଙ୍କୁ  ବି ରକ୍ତ ଏବଂ କ୍ଲା ନ୍ତ କରି ଦେଲା

B.  A. ଏହା ଇତି ହାସକୁ  ଜୀବନ୍ତ କରି ଦେଲା ଏବଂ ସେମାନଙ୍କୁ  ନି ଜ ଐତି ହ୍ୟ ଅନୁ ସନ୍ଧାନ କରି ବାକୁ  ଅନୁ ପ୍ରା ଣି ତ କଲା

C.  C. ଏହା ସେମାନଙ୍କୁ  ବି ଜ୍ଞାନ ପଢି ବାକୁ  ଆଗ୍ର ହୀ କଲା

D.  D. ଏହା ସେମାନଙ୍କୁ  ଶ୍ରେ ଣୀରେ ଯାହା ଶି ଖି ଥି ଲେ ତାହା ଭୁ ଲାଇ ଦେଲା

✓

Q75 Odia
ଅନୁ ଚ୍ଛେଦ ଅନୁ ଯାୟୀ, ଛାତ୍ର ମାନେ କେଉଁ  ବି ଷୟରେ ଶି ଖି ଲେ?

A.  A. ଗଣି ତ ସୂ ତ୍ର  ଏବଂ ସମୀକରଣ

B.  D. ପାରମ୍ପରି କ ରୀତି ନୀତି , କଳା ରୂ ପ ଏବଂ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଐତି ହାସି କ ଘଟଣା

C.  C. ଆଧୁ ନି କ ଖାଦ୍ୟ ପ୍ର ଣାଳୀ କି ପରି  ରନ୍ଧାଯାଏ

D.  B. ସାମ୍ପ୍ରତି କ ରାଜନୈ ତି କ ଖବର

Computer

✓

Q76 Computer
Which option in MS PowerPoint allows you to customize how the
slide show appears during a presentation?

A.  C. View → Notes Page

B.  D. Insert → Options

C.  A. Design → Background

D.  B. Slide Show → Set Up Slide Show

✓

Q77 Computer
A student is learning how to manage files in MS Word 2021. Which
statement is True or False regarding file saving and version control?

(i) The AutoSave feature automatically saves changes to the
document every few seconds, but only if the document is stored in
OneDrive or SharePoint.
(ii) Using the Save As command creates a copy of the document, but
the original file remains unaffected and retains its original name.

A.  D. (i) True, (ii) True

B.  A. (i) True, (ii) False

C.  B. (i) False, (ii) True

D.  C. (i) False, (ii) False

✓

Q78 Computer
Match the following Basic PowerPoint Actions (Column A) with
their corresponding Descriptions (Column B) as used in Microsoft
PowerPoint 2021:

Column A –
PowerPoint Action

Column B – Description

1. File → New
a) Saves the current presentation to the
desired location.

2. Ctrl + S
b) Creates a new blank presentation or
opens templates for selection.

3. Slide Sorter View c) Displays miniature versions of all slides to
rearrange their order.

4. F5 Key
d) Starts the slide show from the beginning
in full-screen mode.

A.  A. 1–b, 2–a, 3–c, 4–d

B.  B. 1–a, 2–b, 3–d, 4–c

C.  D. 1–c, 2–b, 3–a, 4–d

D.  C. 1–d, 2–c, 3–b, 4–a

✓

Q79 Computer
What does WWW stand for?

A.  D. World Wide Web

B.  C. Wide Web World

C.  A. Web World Wide

D.  B. World Web Wide
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✓

Q80 Computer
Which option correctly represents the full form of ROM?

A.  D. Random Operational Memory

B.  C. Read Only Memory

C.  A. Read Operating Module

D.  B. Remote Output Memory

✓

Q81 Computer
Which example correctly pairs system software with application
software?

A.  D. BIOS and Notepad

B.  B. Browser and Mobile App

C.  A. Compiler and Antivirus

D.  C. Firmware and Interpreter

✓

Q82 Computer
Double‑clicking the right border of a column header performs what
action in MS Excel 2021?

A.  B. Sorts data

B.  C. Freezes column

C.  D. AutoFits width to longest entry

D.  A. Deletes column

✓

Q83 Computer
The _____ is used to locate and manage hidden objects on a slide.

A.  B. Format Pane

B.  C. Selection Pane

C.  D. Layers Pane

D.  A. Object Pane

✓

Q84 Computer
Which of the following commands is used normally to refresh a
computer especially when the computer hangs?

A.  B. Shut down

B.  D. Hibernation

C.  A. Restart

D.  C. Log off

✓

Q85 Computer
Which of the following is ROM primarily used for?

A.  C. Storing temporary data

B.  B. Storing permanent data such as the computer’s startup
instructions

C.  A. Storing running programs

D.  D. Storing cached web pages

✓

Q86 Computer
In Microsoft Word, what does the shortcut Ctrl + X do?

A.  D. Saves the document

B.  A. Cuts the selected text

C.  C. Copies the selected text

D.  B. Pastes text from the clipboard

✓

Q87 Computer
What is the purpose of using bullets in MS Word?

A.  B. To sort data

B.  D. To highlight text

C.  A. To list unordered items

D.  C. To align text

✓

Q88 Computer
In an email application, what happens when you click “Reply All”?

A.  A. Replies only to the sender

B.  D. Forwards the message to others

C.  B. Replies to the sender and everyone included in the original
email

D.  C. Sends a blank message
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✓

Q89 Computer
What is the purpose of Excel's DROP function?

A.  B. Excludes a specified number of rows or columns from the
start or end of an array

B.  C. Deletes a specified number of rows or columns of an array

C.  A. Rounds a number up to the nearest even integer

D.  D. Returns the logical value false

✓

Q90 Computer
In MS Excel 2021, which method correctly uses the fill handle to
generate a series of sequential dates across cells?

A.  C. Select the first cell with a date → Click and drag the fill
handle across the desired range

B.  A. Select the entire range → Press Ctrl + Enter to auto-fill
sequential dates

C.  B. Type the first and last date in the range → Click AutoSum to
fill in the rest

D.  D. Enter a date → Use the Insert tab to generate a timeline
chart

Reasoning

✓

Q91 Reasoning
In a certain code language,
'A & B' means ‘A is the wife of B’,
'A – B' means ‘A is the brother of B’,
'A + B' means ‘A is the father of B’,
'A # B' means ‘A is the sister of B’.

How is Q related to T if ‘Q + F – J # I & T’?1968

A.  B. Wife's father

B.  A. Wife's mother's brother

C.  C. Wife's brother

D.  D. Wife's brother's son

✓

Q92 Reasoning
In a certain code language, 'FOUR' is coded as '7542' and 'UNIT' is
coded as '1436'. What is the code for 'U' in the given code language?

A.  B. 1

B.  A. 2

C.  D. 3

D.  C. 4

✓

Q93 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?
VQY43 UPX52 TOW61 SNV70 ?

A.  D. RMU79

B.  A. RMU78

C.  B. RMV79

D.  C. RMV78

✓

Q94 Reasoning
What will come in the place of ‘?’ in the following equation, if ‘+’ and
‘−’ are interchanged and ‘×’ and ‘÷’ are interchanged?

35 ÷ 3 + 81 × 9 − 8 = ?

A.  D. 101

B.  C. 104

C.  A. 110

D.  B. 125
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✓

Q95 Reasoning
Each of B, C, D, E, G, H and I has flight on a different day of a week
starting from Monday and ending on Sunday of the same week. No
one has flight after G. I has flight on one of the days before H. Only
two people have flight between B and D. Only two people have flight
between C and E. Only two people have flight between G and E. D
has flight immediately after H. Who has flight on Tuesday?

A.  B. B

B.  D. C

C.  C. I

D.  A. E

✓

Q96 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.
NLP : LOR
DDV : BGX

A.  C. FHU : DKV

B.  B. OUT : MWV

C.  A. INF : GQH

D.  D. PIN : NLO

✓

Q97 Reasoning
P, Q, R, S, T, U and V are sitting in a straight line, facing the north. No
one sits to the right of S. Only three people sit between S and U.
Only two people sit between U and Q. R sits third to the left of P. T
sits to the immediate right of P. How many people sit between V and
Q?

A.  A. One

B.  D. Two

C.  C. Three

D.  B. Four

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
letter-cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their position in the letter cluster.)

A.  A. IK-MP

B.  C. CE-GI

C.  D. KM-OQ

D.  B. MO-QS

✓

Q99 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: All jams are cobras. All cobras are mugs.
Conclusion (I): Some mugs are cobras.
Conclusion (II): All jams are mugs.

A.  C. Both conclusions (I) and (II) follow

B.  B. Neither conclusion (I) nor (II) follows

C.  D. Only conclusion (II) follows

D.  A. Only conclusion (I) follows

✓

Q100 Reasoning
Each vowel in the word CONVERT is changed to the letter
immediately preceding it in the English alphabetical order and each
consonant is changed to the letter immediately following it in the
English alphabetical order. Which of the following letters will be third
from the left in the new group of letters thus formed?

A.  A. O

B.  B. P

C.  C. M

D.  D. D

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in

	Front & About
	Question Paper  ·  10 Jun 2026  ·  12:30 PM - 2:00 PM
	QMaths · rank.qmaths.in

